# Table of Contents

The FR Calculator/Survey Tool.................................................................................................................. 1  
Overview.................................................................................................................................................. 1  
  Overview of the Main Panel .................................................................................................................... 1  
Calculating a Failure Rate ........................................................................................................................ 2  
Calculated a Failure Rate ........................................................................................................................... 2  
Viewing the Troubleshooting Log ............................................................................................................ 2  
Performing a Temperature Survey ........................................................................................................... 4  
  Performing a Temperature Scan ............................................................................................................. 4  
Reporting .................................................................................................................................................. 5  
  The Survey Report ................................................................................................................................. 5  
  The Survey Diagnostic Report ............................................................................................................... 8  
Performing A Mission Profile Survey ....................................................................................................... 9  
  Performing a Mission Profile Scan ...................................................................................................... 9  
  The Mission Profile Report .................................................................................................................... 12  
Index ...................................................................................................................................................... 15
The FR Calculator/Survey Tool

Overview

Overview of the Main Panel

The Failure Rate Calculator main menu provides the capability to conduct Mission Profiles (a survey over user selected combinations of temperature and environment), Temperature Scans (a survey over a range of temperatures) or Product Tree Failure Rate Calculations at the assembly, board, or part level. These calculations or scans may be conducted using either the Operating or Non Operating Failure Rate Methods.

One major difference between a Product Tree Failure Rate Calculation and the two surveys is that the calculation results of the Product Tree Failure Rate Calculation are retained and stored in the ASENT database, while the survey results are stored only in a temporary report which is deleted when the Survey tool is closed. The user has the capability to save the survey results to a file.

In addition to the 'Calculate' button, the panel consists of 4 menu options, two radio button groups, and a checkbox.

The menu options are:

- **File** - provides the capability to export the results to an Excel spreadsheet and to exit. The Excel option is only presented when the 'Troubleshooting' box is checked and a calculation is performed.
- **Analyze** - provides the capability to set the Calculation Type to either 'Failure Rate Calculator', 'Temperature Scan' or 'Mission Profile'. The initial setting for the Calculation Type is 'Failure Rate Calculator'. The Performing a Temperature Scan section and Performing a Mission Profile section present the details of conducting the respective scans.
- **View** - provides the capability to view the diagnostic reports as well as the survey report. This option is not active until a calculation is completed.
- **Help** – Provides access to this help file.

The radio button groups are:
Calculating Failure Rates

- Failure Rates - provides the capability to select either Operating or Non-Operating FR calculation method.
- Calculation Depth - provides the capability to determine whether any subtree elements will be recalculated.

"Current Assembly Parts" calculates a failure rate for just the node you selected.
"Include Subassemblies" calculates a failure rate for all subassemblies and boards below and including the node you selected.

The 'Troubleshooting' checkbox is only active when the Calculation Type is set to 'Failure Rate Calculator'. Checking the box generates the diagnostic/Pi Factor report for the calculation. This can make the time needed to conduct the calculation significantly longer if a higher level node (such as the system node) has been selected. The diagnostic report is always generated as part of the Temperature Survey or Mission Profile.

Calculating a Failure Rate

1. Click on Calculate.
2. The Failure Rate Calculation screen displays, showing a running status on which board is currently being calculated. The 'Calculate' button changes to 'Cancel' which provides you with a means to abort the calculation. The figure below is a typical calculator progress display.
3. The status bar will read 'Finished' when the calculation is complete and the data has been posted to the database.
4. Selecting 'File|Exit' or selecting the 'open door' exit button on the Failure Rate Calculator toolbar returns to the Reliability Manager where the tree is collapsed and the newly updated return code icons are posted. The Reliability Manager screen displays the return code for the failure rate calculation in the field "fr_op_rc" (for Operating calculations) and in the field "fr_nonop_rc" (for Non-Operating Calculations).

Viewing the Troubleshooting Log

If you click the "Troubleshooting" option on the failure rate calculation screen, the system generates a troubleshooting report that you can use to locate problem parts. The option can be selected at any level. The report output is exportable in Excel format.

The following screen shows the troubleshoot option selected for the failure rate calculation:
Troubleshooting reports display information that was used to calculate failure rates for an individual part or multiple parts depending on where in the project tree the failure rate calculation was performed. It displays all of the factors used in performing the failure rate calculation. This includes default values used (which vary by prediction method) if applied information is not provided, quality factors, environment factors, temperature factors, stress factors, etc., along with any error diagnostics or return codes that resulted from the calculation.

The ASENT Reliability Manager allows the user to generate troubleshooting reports for an individual part, a board or assembly, or the entire project. When generated for an individual part, it acts like the troubleshooting option in the Failure Rate Calculator part level screen. When generated for boards, assemblies, or the entire project the report acts as the Pi Factor report that is in the CARMA toolkit.

Troubleshooting reports can be particularly useful in identifying missing or invalid data that prevents the tool from calculating a failure rate number for a part. Also, it can be quite useful if a customer or user wants to verify that the calculation is being performed correctly for the chosen prediction method.

The report provides the Ref Des, Part Number, Base Failure Rate, Part Failure Rate, Complete list of 'Pi' factors, Environment, Part Description, Failure Rate Calculation Method as well as any diagnostic message generated by the calculator. As with the grids throughout ASENT, the field widths are user adjustable and the columns may also be rearranged by dragging them left or right.
Calculating Failure Rates

A number of viewing options are available by selecting the 'View' menu option from the top of the viewer.

Each option is a multiple select check box. Selecting 'Assemblies Only' reduces the displayed items to only those which are assemblies. This option is very useful when running the calculation at the System or Subassembly level. The 'Hybrid Detail' option expands the data for hybrid microcircuits, showing the same detail for each substrate and each subpart of the substrates. The 'Runs' option is not selectable unless the calculation type is 'Temperature Scan' (See Performing a Temperature Scan).

Once the report options and column arrangement is to the users satisfaction, the report may be exported to Excel by selecting the option from the 'File' menu item.

Several spreadsheets may be made from one report by repetitively exporting, changing options, and/or column formats.

Selecting 'File|Exit' or selecting the 'open door' exit button on the toolbar closes the viewer and returns to the Calculator screen.

Performing a Temperature Survey

Performing a Temperature Scan

To Perform a Temperature Scan:

1. Select the 'Analyze' item on the main menu. A drop-down menu is presented.

2. Select 'Temperature Scan'. A Scan Dialog is presented.

The File Menu and the toolbar both contain 5 options:

- **Open** - Opens a file of scan conditions previously saved.
- **Save** - Saves the scan conditions to a file for reuse.
If a file has been opened or the data has been saved to a file, then the current file name is shown in the status bar at the bottom of the panel.

3. Enter the desired data for the temperature scan and press the 'Ok' button.

Example: The data in the Temperature Scan panel shown above will perform failure rate calculations at 5 degree increments, the first will be at 25 degrees the final will be at 70 degrees. The results for the scan will be saved in a spreadsheet with a column for each temperature and a line for each item (part, assembly, etc).

4. The Survey Tool Main Panel is again active. Note that the Calculation Type has changed.

5. Select the calculation depth and failure rate type calculations desired. The 'Troubleshooting' check box is inactive for Temperature surveys, as the 'Pi' factors are always presented as part of the diagnostics.

6. Press the 'Calculate' button. The progress of the survey calculations is presented in the progress bar, and the current operations are identified in the status line at the bottom of the panel.

7. When the calculations are complete, the progress bar is displayed completely filling the allocated area and the status line presents the word 'Finished' (clever, huh?). The 'View' option of the menu becomes active.

**Reporting**

**The Survey Report**

The Survey Report is only available after a Survey calculation is completed. The availability is signified by the 'View' option of the main menu being active. The report is deleted when the Survey Tool exits unless the user has saved the report to a file. To View the Survey Report, select the 'View' option. A drop-down menu is presented with two options. Select the 'Survey' Option.
Calculating Failure Rates

Another full screen panel presents the report. This is another full featured panel with a menu and toolbar. The menu options are:

- **File** - Provides the capability to save the report as an Excel spreadsheet. Exit is also an option from this menu.
- **View** - This is a submenu that provides access to the graphical output reports as well as the option to show or hide the part level data of the report.

![Survey Report Panel](image)

- **Help** - Provides access to this Help file.

<table>
<thead>
<tr>
<th>Indenture</th>
<th>Parent Name</th>
<th>Ref Des</th>
<th>Part Number</th>
<th>Description</th>
<th>3S</th>
<th>40</th>
<th>45</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>TESTCCA</td>
<td>1A1A7</td>
<td>2A0087</td>
<td>Test CCA for imports</td>
<td>12.350395</td>
<td>14.250297</td>
<td>16.091957</td>
</tr>
<tr>
<td>3</td>
<td>TESTCCA</td>
<td>C0001</td>
<td>12305876400301</td>
<td>CAPACITOR</td>
<td>0.000705</td>
<td>0.000791</td>
<td>0.000294</td>
</tr>
<tr>
<td>3</td>
<td>TESTCCA</td>
<td>H1/1</td>
<td>230058431</td>
<td>RF Amp</td>
<td>6.762238</td>
<td>8.653384</td>
<td>11.391</td>
</tr>
<tr>
<td>4</td>
<td>TESTCCA</td>
<td>1</td>
<td>H23003431</td>
<td>HYBRID SUBSTRATE</td>
<td>0.766194</td>
<td>0.847591</td>
<td>0.906364</td>
</tr>
<tr>
<td>5</td>
<td>TESTCCA</td>
<td>C1-4</td>
<td>Cap</td>
<td></td>
<td>0.003128</td>
<td>0.003961</td>
<td>0.004736</td>
</tr>
<tr>
<td>5</td>
<td>TESTCCA</td>
<td>C12</td>
<td>PET</td>
<td>PET</td>
<td>0.0236672</td>
<td>0.025774</td>
<td>0.028905</td>
</tr>
<tr>
<td>4</td>
<td>TESTCCA</td>
<td>2</td>
<td>H23004101</td>
<td>HYBRID SUBSTRATE</td>
<td>0.786194</td>
<td>0.847591</td>
<td>0.906364</td>
</tr>
<tr>
<td>5</td>
<td>TESTCCA</td>
<td>C1-4</td>
<td>Cap</td>
<td></td>
<td>0.003128</td>
<td>0.003961</td>
<td>0.004736</td>
</tr>
<tr>
<td>5</td>
<td>TESTCCA</td>
<td>C1-2</td>
<td>PET</td>
<td>PET</td>
<td>0.0236672</td>
<td>0.025774</td>
<td>0.028905</td>
</tr>
<tr>
<td>4</td>
<td>TESTCCA</td>
<td>3</td>
<td>H2300431</td>
<td>HYBRID SUBSTRATE</td>
<td>5.234</td>
<td>5.95907</td>
<td>5.21389</td>
</tr>
<tr>
<td>5</td>
<td>TESTCCA</td>
<td>C1</td>
<td>Cap</td>
<td></td>
<td>0.003128</td>
<td>0.003961</td>
<td>0.004736</td>
</tr>
<tr>
<td>5</td>
<td>TESTCCA</td>
<td>C2-4</td>
<td>Cap</td>
<td></td>
<td>0.003128</td>
<td>0.003961</td>
<td>0.004736</td>
</tr>
<tr>
<td>5</td>
<td>TESTCCA</td>
<td>D1</td>
<td>Diode</td>
<td>Diode</td>
<td>0.002989</td>
<td>0.003106</td>
<td>0.00276</td>
</tr>
</tbody>
</table>

Selecting the 'View' item on the menu results in a three item drop down menu. For the 'Assemblies Only' item, is a checklist item. It is selected when the check is present next to the item. Click on the item to toggle the check between on and off. Selecting either one of the Graphical reports will create an Excel Spreadsheet with either the line or Bar chart presentation of the survey results.
The FR Calculator/Survey Tool

Selecting the ‘File’ menu opens a drop down menu with two options: ‘Export to Excel’ and ‘Exit’. Selecting the ‘Export to Excel’ option will open a panel as the Excel spreadsheet is built, with a bar to indicate the progress of the process. Following the completion of the spreadsheet, the survey report will be launched and displayed in Excel. From here, the user may view the report, print it or save it off as a file.

Selecting the ‘Exit’ option, by clicking on the open door on the toolbar, or selecting the ‘File | Exit’ item, returns to the Survey panel.

The Mission Profile Survey Report differs only in the column heading for the failure rate columns.

Selecting the 'File' menu opens a drop down menu with two options: 'Export to Excel' and 'Exit'. Selecting the 'Export to Excel' option will open a panel as the Excel spreadsheet is built, with a bar to indicate the progress of the process. Following the completion of the spreadsheet, the survey report will be launched and displayed in Excel. From here, the user may view the report, print it or save it off as a file.

Selecting the 'Exit' option, by clicking on the open door on the toolbar, or selecting the 'File | Exit' item, returns to the Survey panel.

The Mission Profile Survey Report differs only in the column heading for the failure rate columns.
The Survey Diagnostic Report

The Survey Diagnostic Report is only available after a calculation is completed. The availability is signified by the 'View' option of the main menu being active. The report is deleted when the Survey Tool exits unless the user has saved the report to a file.

To View the Survey Diagnostic Report select the 'View' option. A drop-down menu is presented with two options.

- The 'Diagnostic option' presents a spreadsheet for each run of the survey. Select the 'Diagnostic' Option. Another full screen panel presents the diagnostics. This is another full featured panel with a menu and toolbar. The menu options are:
  - File – Provides the capability to save the diagnostics as an Excel spreadsheet. The Workbook will consist of a single worksheet consisting of the data in the presently selected data grid. Exit is also an option from this menu.
  - View - Provides a number of options to tailor the presentation of the diagnostic report.
  - Help - Provides access to the Help Contents for failure rate calculation, How to use Help, the About box (which provides the detailed version of the installed client tools), and access to the rest of the topics in the Reliability Manager Help file.

The 'Diagnostic option' presents a spreadsheet for each run of the survey. Select the 'Diagnostic' Option. Another full screen panel presents the diagnostics. This is another full featured panel with a menu and toolbar. The menu options are:

- File – Provides the capability to save the diagnostics as an Excel spreadsheet. The Workbook will consist of a single worksheet consisting of the data in the presently selected data grid. Exit is also an option from this menu.
- View - Provides a number of options to tailor the presentation of the diagnostic report.
- Help - Provides access to the Help Contents for failure rate calculation, How to use Help, the About box (which provides the detailed version of the installed client tools), and access to the rest of the topics in the Reliability Manager Help file.
1. Select the 'View' option of the main menu. A drop down menu is presented. The drop down for the Temperature Survey and Mission Profile Surveys differ only in the identification of the runs.

```
View

Assemblies Only

Hybrid Detail

Runs

35 degrees Ctrl+1
40 degrees Ctrl+2
45 degrees Ctrl+3
```

The 'Assemblies Only' and 'Hybrid Detail' items are checklist items. They are selected when the check is present next to the item. Click on the item to toggle the check between on and off. The 'Runs' item presents a pull down list of the Survey runs conducted (in the example above 3 runs were conducted). Selecting one of these items will replace the data in the spreadsheet with the diagnostics from the selected run.

Selecting the 'File' menu opens a drop-down menu with two options: 'Export to Excel' and 'Exit'. Selecting the 'Export to Excel' option will open a panel as the Excel spreadsheet is built, with a bar to indicate the progress of the process. Following the completion of the spreadsheet, a standard windows 'Save File' dialog is presented providing the capability to specify the file name and the location (Drive, directory, etc.) where the file is to be stored.

Selecting the 'Exit' option, by clicking on the open door on the toolbar, or selecting the 'File | Exit' item, returns to the Survey panel.

**Performing A Mission Profile Survey**

**Performing a Mission Profile Scan**

To Perform a Temperature Scan, select the 'Analyze' item on the main menu. A drop-down menu is presented.

```
Analyze

View

Help

Failure Rate Calculator

Temperature Scan

Mission Profile
```

Select 'Mission Profile'. The Mission Profile Editor is presented.
Calculating Failure Rates

The panel is initially presented without a profile selected, which is what the 'None' in the drop down window indicates. The Mission Profile Editor has a toolbar with 5 buttons. The status of the buttons (whether they are selectable or not) is determined by whether a profile has been selected. These buttons are:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Button" /></td>
<td>Save the current profile.</td>
</tr>
<tr>
<td><img src="image2.png" alt="Button" /></td>
<td>Save the selected profile as a different profile.</td>
</tr>
<tr>
<td><img src="image3.png" alt="Button" /></td>
<td>Delete the selected profile.</td>
</tr>
<tr>
<td><img src="image4.png" alt="Button" /></td>
<td>Create a new Profile</td>
</tr>
<tr>
<td><img src="image5.png" alt="Button" /></td>
<td>Return to the Survey Panel.</td>
</tr>
</tbody>
</table>

To create a new profile, press the 'New Profile' button ( ![Button](image6.png) ). A panel is presented to allow you to give the profile a name.

![Panel](image7.png)

Enter the new name and press enter. Each profile must have a unique name, and the editor will check the name when you press the 'OK' button and let you know if there is already a profile by the name you input, if so you will have the opportunity to change the name to something unique. After entering the name, the profile grid becomes active and the first row (sequence) of the profile is presented.

![Profile Grid](image8.png)

A mission profile is comprised of a series of sequences, each with their own temperature, environment, and method (Op or NonOp) as well as their percentage of the mission or life cycle (which ever you are using as the basis for your presentation). The black arrow on the left hand side of the grid indicates the currently selected sequence. Fill in the data for the first sequence.

Pressing the ‘Add Row’ button ( ![Button](image9.png) ) saves the data and adds another sequence.
The other buttons that work with the selected sequence are the ‘Up’ and ‘Down’ buttons on the right side of the grid which provide you the capability to modify the order of the sequences, moving them up or down in the order. The ‘Delete Row’ button deletes the currently selected row. The ‘OK’ button reurns to the Survey main panel and changes the calculation type to ‘Mission Profile’. The ‘Cancel’ button returns to the Survey panel but does not change the calculation type. The profile data is saved as it is input, regardless of whether the ‘OK’ or ‘Cancel’ button is selected.

Profiles are stored on your workstation in the ASENT\Data directory. The MissionProfiles.db file provides the storage for profiles. If you want to share your profiles with others, you need to provide them a copy of this file. A list of available profiles is presented by pressing on the arrow next to the profile name.

Selecting one of these profile names loads the profile data into the grid where you can edit the data or use the data for calculation (by pressing the ‘OK’ button).

Upon returning to the Survey screen you will notice that the Calculation Type on the main panel has changed to ‘Mission Profile Survey’.
Pressing the 'Calculate' button generates the survey data based on your mission profile. The 'View' menu item becomes active when the calculation is complete, and you can see the results in the Survey Report and the Diagnostics Report (see Reporting).

The Mission Profile Report

The Survey report for the Temperature Scan and the Mission Profile look the same in the Survey Tool. The difference occurs when the Survey report for the Mission Profile Survey is exported to Excel. During the export, the additional lines for the summaries, using the percentages you input are added. The total failure rates are summed for each column and multiplied by the percentages. These sums are summed for the entire profile to provide a profile failure rate and a MTBF using the assumption of the logarithmic model on which the failure rate calculations were based.
Reference Designator: TA1A3  
Name: SC/ND  
Description: Sound Card

### Mission Segment VS Reliability

<table>
<thead>
<tr>
<th>Mission Segment</th>
<th>Failure Rate (Million Hrs)</th>
<th>MTBF (Hrs)</th>
<th>Reliability Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>AUF/55/Sp</td>
<td>40.18</td>
<td>24,007.97</td>
<td>0.793793</td>
</tr>
<tr>
<td>G4/00/Sp</td>
<td>14.91</td>
<td>67,090.46</td>
<td>0.877669</td>
</tr>
<tr>
<td>NS/00/Sp</td>
<td>0.85</td>
<td>1,174,200.98</td>
<td>0.992698</td>
</tr>
</tbody>
</table>

**Graphs:**
- Mission Segment VS Failure Rate
- Mission Segment VS MTBF
<table>
<thead>
<tr>
<th>Letter</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>Calculating a Failure Rate</td>
<td>2</td>
</tr>
<tr>
<td>O</td>
<td>Overview of the Main Panel</td>
<td>1</td>
</tr>
<tr>
<td>P</td>
<td>Performing a Mission Profile Scan</td>
<td>12</td>
</tr>
<tr>
<td></td>
<td>Performing a Temperature Scan</td>
<td>4</td>
</tr>
<tr>
<td>T</td>
<td>The Mission Profile Report</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>The Survey Diagnostic Report</td>
<td>10</td>
</tr>
<tr>
<td>V</td>
<td>The Survey Report</td>
<td>6</td>
</tr>
<tr>
<td></td>
<td>Viewing the Troubleshooting Log</td>
<td>2</td>
</tr>
</tbody>
</table>